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Preface

This User Guide is been implemented by Boot & Work, Satarking
under the namelndustrial Shields.

Purpose of the manual

The nformation contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience

I -.'H"\.

1

E)

This User Guide is intended for the following andie

.

9 Persons in charge of introducing automation devices.

1 Persons who design automation systems.

1 Persons who install or connect automation devices.

1 Persons who manage working automation installation.
» Warnings:

Unused pins should not be connecteghadring the directive may damage the

controller.

Improper use of this product may severely damage the controller.

Refer to the controller’”s User Guide regard
Before using this product, it is the responsibility of the usertotedde pr oduct ' s Us
Guide and all accompanying documentation.



Application Considerationsand Warranty

Read and Understand this Manu

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standardst hat apply to the combination of products
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

1 Systems, machines, and equipment that could present a risk to life or property.

T Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

I Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

A

At the customerdés request, | NDUSTRI AL SHI ELDS v
certification documents identifying ratings and limitations of use that apply to the

products. This information by itself is not sufficient for a complete determination of the

suitability of the products in combination with the system, machine, end product, or

other application or use.



Disclaimers

Weightsand Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in

determining suitability and does not constitute a warranty. It may represent the result of

| NDUSTRI AL SHI ELDS6s test conditions, and t he
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS

Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or stablish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.

Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.



Warranty and Limitations of Liability

Warranty

I ndustri al Shieldsés exclusive warranty is that
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,

REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL

SHI ELDS6S ANALYSI S CONFI RMS THAT THE PRODUCTS \
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO

CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR

REPAIR.
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INDUSTRIAL SHIELDS

1 General Description Wi-Fi & Bluetooth CONTROLLER

1.1 Zone- Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is
important to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the
shield from below and C the shield from above. Having a B in the middle of them. It has
3 zones (A, B, C):

EEF L §4:
zZzZzZ s zzZ
000 000
N N N N N N
<mO O m<

. C ZONE

: B ZONE

| .a=r,' AZONE

1 The inputs in the zone B are named 10.X, being X any number suitable in the
Shield. Digital Outputs are named as Q0.X and Analog Outputs as A0.X.

1 The inputs in the zone C are named I1.X, being X any number suitable in the
Shield. Digital Outputs are named as Q1.X and Analog Outputs as A1.X.



ZONE A ) + ZONEB }4‘ ZONE C

1.2  Zone Distribution
\
Communication
1.3 A Zone Features

\ A
N 4

=  Analog ’ Analog

B

Digital

*  Digital

Shield

A Zone

Communication
Shield

(1x) Ethernet

(1x) USB

(1x) 12C

(3x) TTL

(1x) RS-232

(1x) HALF/FULL Duplex RS-485
(1x) SPI external Port

(1x) RTC

(1x) uSD Socket

(1x) WiFi & BLE




1.4 Mechanical dimension

= < ?
o M-Duino 2 BLOCKS
m 1/Os

94,7 101




1.5  GeneralFeatures

CONECTABLE PLC ARDUINO 24Vcc M-DUINO

MODEL TYPE

WiFi & BLE Controller General Spec.

Fuse protection (2.5A)

Input Voltage 12 to 24Vdc Polarity protection
| max. 1.5A
Size 101x119.5x94.7 101x119.5x119.3
Clock Speed 16MHz
Flash Memory 256KB of which 8KB used by bootloader
SRAM 8KB
EEPROM 4KB

Communications

12C 7 Ethernet PortT USB 1 WiFi &BLE T

1 (1x) Rx, Tx (Arduino pins)

RS4851 RS232 -- SPI

Max232-Max485-W5500-ESP32

USB consideration!

Only meant for uploading or debugging, not always connected

as a serial in a project!

Cannot be working in a final
application

An/Dig Input 10bit
(0-10Vcce)

0to 10V
Input Impedance: 39K
Separated PCB ground

Digital Isolated Input (24vcc)

7 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation

* Interrupt isolated Input HS
(24Vce)

7 to 24Vdc
I min: 2to 12 mA
Galvanic Isolation

Analog Output 8bit
(0-10Vcce)

0 to 10Vdc
I max: 20 mA
Separated PCB ground

Digital Isolated Output (24Vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay

Imax 24Vdc: 410 mA

PWM lIsolated Output 8bit
(24vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay

Expandability

12C - 127 elements - Serial Port RS232/RS485/WiFi/BLE

* By using this type of signal can no longer use Digital signal (24Vdc)




2 Technical Specifications:

2.1 General Specifications:

Item

M-DUINO B ZONE

Power supply

voltage DC power supply

12 to 24Vvdc

Operating

voltage range DC power supply

11.4 to 25.4Vdc

Power
consumption DC power supply 30VAC max.
Power supply 24vdc
External voltage
power supply
Power supply 700Ma

output capacity

Insulation resistance

20 MY mioOfVdaketween the AC terminals and the protective earth terminal.

Dielectric strength

2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the
external AC terminals and the protective ground terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 45°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 552g max.

2.2 Performance Specification:

Arduino Board

ARDUINO MEGA 2560

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programmi ng | angu a g bttp:/afdsirio.ctieh/ButorialfHomePagyee Co .

Microcontroller

ATmega2560

Flash Memory

256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB
EEPROM 4KB

Clock Speed 16MHz

Clock Speed 16MHz



http://arduino.cc/en/Tutorial/HomePage

3 Precautions

Read this manual before attempting to use é&Fi & BLEPLCand follow its descriptions for
reference during operation.

3.1 Arduino Board

TheMDUINO PLERDUINO ETHERNET & WIFI & BUBANALOG/DIGITRLUSncludes
anArduinoMegaBoard as controlleand a ESP32 Dev programmable chip as-&i\&iBLE
gateway

3.2 Intended Audience

This manual is intendefr technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operat®i-Duinoaccording to the performance specifications described in this
manual.

Before using thilDUINO PLBRDUINO ETHERNET & WIFI & BLEZIANAOG / DIGITAL
PLUSinder different conditions from what has been specified in this manual or integrating

into nuclear control systems, railroad systems, aviation systems, vehicles, combustion systems,
medical equipment, amusement machines, safety equipnaat other systems, machines,

and equipment that may have a serious influence on lives and property if used improperly,
consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance
characteristics ofhe Ethernet/WiFi/BLEontroler are sufficient for the systems, machines,

and equipment, and be sure to provide the systems, machines, and equipment double safety
mechanisms. This manual provides information for programming and operatingEtéNO
PLCARDUINO ETHERNET & WIFI & BUBIANALOG / DIGITRLUS

4 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provés lots of libraries that helps in the programming.

Industrial Shields provides boards for programming the PLCs much easier. Basically it is no
needed to define the pins and if that pins are inputs or outputs. Everything is set up
automatically if usinghe boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to have always the latest version).



Steps:

1. Open Arduino IDEBndgo to: “File-> Preferencéslocated inthe top left corner.
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2. In Additional BoardManagerURLs write the following:

http://apps.industrialshields.com/main/arduino/boards/géage industrialshields index.json

3. Press OK to save the changes.

4. Goto: Tools> B o a-¥ Rbards Manager
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http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json

5. Search fof'industrialshields on the browse.

& Boards Manager

y Tope [all | | industrialshields
industrialshields

Boards induded in this package:
ARDBCH Farraly, M-Duinc family.

2oling halg

Maora infa

1148

Inzsal
Clese
6. Click install (selecting the latest version).
Following thesesteps you will be db to see now the Industrial Shields Boards:

Pt Anbw

Ot B bt

Pigeman Sieu e

[ETYSe—



Once it is selected the Ardbox Family oiMino family an extra option will appear on Tools:
There, it can be selected the exact model for every family.

& Blink | Arduino 1.8.0
File Edit Sketch Tools Help

Auto Form at Cirl+T
Archive Sketch

Fix Encoding & Reload

Serial Monitor Ctrl+Shift+M
Serial Plotter Cirl+Shift+L

WiFi1101 Firmware Updater

Board: "M-Duino family" >

Industrial Shields: "M-Duino 19R+" M-Duino 19R

Port e M-Duino 19R+

Get Board Info M-Duino 21

i M-Duino 21+

Programmer: "Arduino Gemma" .
M-Duino 38AR +

Burn Bootloader .
M-Duino 38R
M-Duino 38R+
M-Duino 42
M-Duino 42+

M-Duino 50RRA +
M-Duino 53ARR+
M-Duino 54ARA+
M-Duino 57 AAR+
M-Duino 57R
M-Duino 57R+
M-Duino 58
M-Duino 58+

Also there are some examples of programming lie & Examples>M-DuinoFamily.
Furthermore there are some extra ldres that can be found in Industrial Shields github.

https://qgithub.com/IndustrialShields/



https://github.com/IndustrialShields/

5 How to connect PLC Arduino to PC

Connect USB port from PLC to PC.

NOTE: ‘ -
M-DuinoFamily use USBBcable. 2

- Open Arduino IDE interface:

- Selectindustrial Shields bads ->M-DuinoFamily

- Select the corred-DuinoBoard
M-Duino 42

- Select correct port.

TR L | —




6 How to connect PLC to power supply

- M-Duino FamilyPLCs are 124Vdc supplied. IMPORTANT: The pol&&tNOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not lgthan 24Vdc.

'7:"&‘\'5?- Sup PI.:I
GBoo |

I—* abvee |

et |

- Suggested power suppliers

Jackconnectorneeds to be removednd use the live

\‘
g
.
.
.
* Not recommended for industrial applicatiorithe T
and GND connectors. i h



7 M-duino Family Pinout

7.1

A Zone connection

Base

(common unit)

A Zone
5 £
=t o
£8 | ¢ §
3e| 3 5
=0 < [
SCL 21 12C/SS
SDA 20 12C/SS
RX0 1 RXO0/SS
TXO0 0 TX0/SS
RX1 19 DONO&T USE
TX1 18 DONOT USE
> 16 RX2(serial 2)
RX 17 TX2(serial 2)
Z- - RS485
Y+ - RS485
B- - RS485
A+ - RS485
PIN3 3 Arduino Pin
50 SO 50 SPI
51 SI 51 SPI
52 SCK 52 SPI
Reset | Reset SPI
Vin5 Vin5 5V
PIN2 2 Arduino Pin
GND - Gnd
GND - Gnd
24Vdc Power Supply

Base
(common unit)
A Zone
5 £
o
o =
£8 o S
S C 5 S
25| 3 =
=0 < o
AREF AREF  |Arduino PIN
IOREF2 | IOREF2 [Arduino PIN
IOREF1 | IOREF1 [Arduino PIN
7Vdc 7Vdc -
GND GND GND
3.3vdc | 3.3vdc |Arduino PIN
GND GND GND
5vdc 5Vdc -
GND GND GND

Configuration Switchfsee sectior8 for
configuring the communications
Enabling communications disables some
I/Os)

Communication PinsSgrial 1 is used by
the ESP32 Wi & BLE integrated
module)

Power supply connectors
(24Vdc-GND)

DS3(SD)
FO rgass HD




Laal 4 3
Ml‘ .Mla-l

l HTC Battwry 1«75“ i‘:a:.p/ \

Ethernet Audno Power
Connector Reset button

USB programmer Autoreset
connector

*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using
serial communication. When uploading code to Arduino Mega set switch to ON.



7.2 B Zone (Analog Shield)
[
- |
B Zone
—_ c
o8 a —T-
S o o c Analog
8 2 £ 2 0-30vde
i | 3 g o8
8 j 5 240
Dugtat
10.12 59 Analog/ Digital In q:'J'v")
10.11 58 Analog/ Digital In
10.10 57 Analog/ Digital In
10.9 56 Analog/ Digital In
10.8 55 Analog/ Digital In
10.7 54 Analog/ Digital In
(1)10.6/INT1 - GND 10.6
10.6/INT1t 3 Interrupt 1 In
(1)10.5/INTO - GND 10.5
10.5/INTO* 2 Interrupt O In S ]
(0.4 - GND 10.4 05951044
10.4 26 Digital Input 310 4y
()10.3 - GND 10.3 04
10.3 25 Digital Input lenan
()10.2 - GND 10.2 310 2t
10.2 24 Digital Input 02 <
()10.1 - GND 10.1 Lcdign |
10.1 23 Digital Input £ 10 O
()10.0 - GND 10.0 00 ool
10.0 22 Digital Input
Top Zone
- -
Led indicator 1/Os state
B Zone
o =
c o £ 3
5% | & 5 o
Qc e & B
=5 5 5 ove
o S . I
GND GND GND
AO0.7% 6 Analog Out
A0.61 5 Analog Out B
AO0.5¢ 4 Analog Out &

Q/Vdc = External Isolated Out Vdc g Ao
COM(-) - External Isolated Out GND T NS ¥
Q0.71 6 Digital/PWM Out 8 NG5
Q0.6¢ 5 Digital/PWM Out g 0 s

Q0.5! 4 Digital/PWM Out Eud
Q0.4 40 Digital Out gga
Q0.3 39 Digital Out c2k
Q0.2 38 Digital Out 25¢
Q0.1 37 Digital Out R

Q0. 36 Digital Out

Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs (isolated)

Configuration Switch*
(see section 8 to select the correct
configuration for outputs).

Analog Outputs

Voltage Supply/Reference for
Digital/PWM Outputs (isolated)

PWM/Digital Outputs

1 See sectio to select suitable switch configuration for enable these connections.



73 C Zoneg(Analog Shield
N
C Zone Tl
o5 £
= o
= ° 5 %
Ac = = 3
35 | 2 g
O < L:L) 5 - MW
11.12 65 Analog/ Digital In Dvptad
11.11 64 Analog/ Digital In i
11.10 63 Analog/ Digital In
11.9 62 Analog/ Digital In 1 12
11.8 61 Analog/ Digital In nn
11.7 60 Analog/ Digital In FLAN
(-)I1.6/INT1 - GND 11.6 ns _
11.6/INT1% 19 Interrupt 1 In NY —oTo-
(-)I11.5/INTO - GND I1.5 NTe
11.5/INTO? 18 Interrupt O In 1 GNTE
()14 - GND 11.4 1 SINTE
11.4 31 Digital Input 19 Atk
()13 - GND 11.3 4 A
11.3 30 Digital Input )11 3
()12 - GND 1.2 LG
11.2 29 Digital Input 2 %
(1 - GND I11.1 YLK B
12.1 28 Digital Input e,
()10 - GND 11.0 10
11.0 27 Digital Input [
- |
Top Zone ¢
Q l- -~
O [y .I ] - ]_.1 I |_
Led indicator I/Os state
C Zone 2§y
=*o1e
#s a1sl
25 c :
=3 T 5 " oo
3¢ | ¢ £ e
s c % c Dot
o) > s
O = w
<
GND GND GND — |GNO |
ALT! 7 Analog Out X v ull e
Al.6t 9 Analog Out * S ars |
Al15! 8 Analog Out 2
Q/Vdc - External Isolated Out Vdc -4
COM(-) - External Isolated Out GND £
QL.7: 7 Digital/PWM Out !
Ql.6* 9 Digital/PWM Out ; =
Q15! 8 Digital/PWM Out 8-
Q1.4 45 Digital Out g8L
Q1.3 44 Digital Out «25
Q1.2 43 Digital Out Zgt ‘
Q1.1 42 Digital Out o gl
Q1.0 41 Digital Out

Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs (isolated)

ConfigurationSwitch*
(see section 8 to select the correct
configuration for outputs).

Analog Outputs

Voltage Supply/Reference for
Digital/PWM Outputs (isolated)

PWM/Digital Outputs

See sectio to select suiable switch configuratin for enable these connections



B8 Switch Configuration

8.1 A Zone:Communications

LEFT ZONE
Switch | ON | OFF
C ZONE
RX1/11.6 11.6 RX1
TX1/11.5 11.5 TX1
B ZONE
Pin 3/10.6 10.6 Pin 3
Pin 2/10.5 10.5 Pin 2
usSD & Rg85
D53(SD) Q2.0 SD
FDRS485 HD| HD FD

’orr . an
SCL/12.8

sDA /12.5 | B ‘
£ Rx1/11.6 ) N
| | Tx1/11.5 a
! Pin3/1086 : e
Pin2/10.5 . N
. D53(SD) =3

4.SCL/12.6ALWAY ATOFFPOSITIONDOnthe MDUINO PLERDUINO ETHERNET & WIFI &
BLE 42/0s ANALOG/DIGITRLUS ontrollerthis switchis not connected

3. SDA/I2.5 ALWAY ATOFHFPOSITIONOnthe MDUINO PLC ARDUINO ETHERNBFI&W
BLE 42/0s ANALOG/DIGITRLUS ontrollerthis switchis not connected

2. RX1/11.6Choosing between RX1 or the input 11.6. If this switch is ON, it enables the 11.6
input and disables theXRL. If this switch is OFF, it enables RX1 and disables 11.6.

1. TX1/11.5:Choosing between TX1 or the input I11.5. If this switch is ON, it enables the 11.5
input and disables the TX1. If this switch i$QFenables TX1 and disables 11.5



4.Pin3/10.1: ChoosindgetweenPin3 or the input 10.6. If this switch is ON,it enablesthe 10.6
input anddisablesthe Pin3. If this switchis OFFjt enablesPin3 anddisabled0.6.

3. Pin2/10.0: ChoosingbetweenPin2 or the input 10.5.1f this switchis ON,it enablesthe 10.5
input anddisableghe Pin2. If this switchis OFFjt enablesPin3 anddisabled0.5.

2.D53(SD)ALWAYRATOFRPOSITIONOna MDUINO PLERDUINO ETHERNET & WIFI & BLE
421/0s ANALOG/DIGITRLUZontrollerthis switchis not connected It allowsthe uSD
storage.

1. FDRS485HD: ChoosingetweenFDor HF.If this switchis ON, it enablesthe HalfDuplex
(HD)option anddisableshe FD.If this switchis OFFjt enablesFullDuplex(FD)anddisables
HD.

LEFT ZONE - 1d
SWITCH ON OFF
NC - -
NC -

RTC SCL RTC -
RTC SDA RTC -

1. RTC SDAhis switch eables the communication to communicate with the RTC
using 12C. Having this switch in ON mode it actives this communication,
whereas if it is in OFF mode it disables the 12C to reach the RTC.

2. RTC SCrhis switch enables the communication to communicaitnwhe RTC
using 12C. Having this switch in ON mode it actives this communication,
whereas if it is in OFF mode it disables the 12C to reach the RTC.

3. NC:No t connected. This switch is not
if it is in ON mode or EF mode.

4. NC:INo 't connected. This switch 1 s not
if it is in ON mode or OFF mode.

conn

conn



8.2 B Zone:AnalogShield

B ZONE C ZONE
SWITCH| ON | OFF SWITCH| ON | OFF
NC - - NC - -
Q0.7 | Q0.7| A0.7 Q17 | Q17| ALY
Q0.6 | Q0.6| A0.6 Ql6 | Q16| Al6
Q0.5 | Q0.5| A0.5 Q15 | Q15| Al1S5

NC
18 &?7 gg QL7
§§ Qo8 22la1s
z4 00:5 Z5lQ15

For theAnalogShiet (Zone B & Zone @)a switch is set to ON, it can only act as Digital
Output. If it is set to OFF it can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented witf0.X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide
this analog output is represented wittDA, being X any number of the tables above.

9 1/0Os 5V pins

TheMDUIND PLC ARDUINO ETHERNET & WIFI42 BDE ANALOG/DIGITRLUSas some

of the Mega board pins available. édepins can be programmed according to Arduino
features such as 1/Os operating at 5V or any additional features present in the pins (for
examplel2C communication in pins SCL and SB#\}his pins are directly connected to the
Arduino Mega board they are not as well protect as the normal inputs. These pins are mainly
meant to be used as prototyping.

The Arduino board available pins are summarizetthe table below. In ater to access some
of thesepins the configuration switch must be set to OFF position (see sefjtemd some
extra considerations must be taken in consideration when using these pins

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TX0 1
RX1 19 DONO6T USE!
X1 18 DONOT USE!




MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF
Pin 2 2 Communication switch: OFF

*IMPORTANTDo not connect théerminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Mega board.

A part from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerationperate with these pins.

In the WiFi & BLE ontroller, Serial @x1 & Rx1)s used to communicate through tHeSP32
integratedin the MDUINO PLC ARDUINO ETHHRIWIFI & Bl421/0s ANALOG/DIGITAL
PLUS

9.1 12C pinsz SDA/SCL

The 12C protocol is meant to work in a puil configuration. A pulip configuration means
that when the pin is at rest (nothing connected to it) it always remH$GH value. In this case
it reads 5V when ndiing is connected. The pulp configuration is stablished by default in
these pins.

If it is meant to work them as a GPAOBV, it has to be considered that they are pulb
inputs.

*IMPORTANT: 12.5 & 12.6 are not pufl inputs although they are refexd to the 12C pins
(switch configuration). There& “ r epulleipy ciromit“that is stablished in order to have the
same behaviour as the other inputs.

9.2  Serial 07 RX0/TX0

The SerialO protocol can work also as a 5V pin. These pins should be usettlyltiomdy in

case that all the 5V pins are already performing a function. This is because they are shared
with the USB interface. If using these pins, the USB communication cannot be working at the
same time. When the PLC is not installed, the USB conwatiion is normally required for
debugging, uploading and intercommunicating with &thernet controller If using both
interfaces athe same time theArduino boardwill get blocked.

These pins are not stablished with a pyl or a puldown configuraibn. The state of these
pins isunknown. If these pins must be used, they require a-pplbr a puldown
configuration. The Arduino board allows the pins to be set in aygudonfiguration. If not it
must be stablished an external pulp or pulidown drcuit in order to correctly work with
these pins.

9.3 Serial 17 RX1/TX1

In the WiFi & BLEontroller, Serial 1 is used to communicate throughE$#3tegratedin
the MDUINO PLC ARDUINO ETHERNET & WIFAZIBIEANALOG/DIGITRLUS
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9.4  SPIz MISO/MOSI/SCK

These pins can only work as a 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time as the Etherneind not work.

These pins are not stablished with a puytl or a pulldown configuration. The state of these
pins is unknown. If these pins must be used, they require aupudir a puldown
configuration. The Arduino board allows the pins to be setpalaup configuration. If not it
must be stablished an external pulp or pultidown circuit in order to correctly work with
these pins.

9.5 Pin 2/Pin 3

These pins are only referred to the inputs 10.5/10.6. If the switch configuration is in OFF
position thepinsPin 2/Pin 3 will be available.

These pins are not stablished with a pytl or a puldown configuration. The state of these
pins is unknown. If these pins must be used, they require aupudlr a puldown
configuration. The Arduino board allows thms to be set in a pullp configuration. If not it
must be stablished an external pulp or pultidown circuit in order to correctly work with
these pins.



10 A Zone Features: Communications & RTC & uSD

10.1 RS232

The Arduino Mega function code &mcess the R&32 port in the MDuino is Serial2 (pins 16
and 17 of the Arduino Mega).

FortheR®2 32 communi cation protocol there isn’
matter the configuration of the switches to implement a-B& communicatia.

Using the boards of Industrial Shields, there is a library that simplifies tR8RS
implementation.

10.2 RS485

For RS485 communication protocol the defined Arduino Mega pins are showed in the chart
below.

Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the RE85communicationprotocol there is only one switch that affects in this
communication. The R&5 protocol will be always enabled, the only switch that affects is the
one cal#4e8d® HPD (&8s sWitehontakedtine choosibgtween RS185

Half Duplex or R&35 Full Duplex (R&2).

Using the boards of Industrial Shields, there is a library that diegpthe R8185
implementation.

10.3 12C

12C communicatioDOES NOT REQUERrRRuUIFUp resistorfor the M-Duino FamilyThe pulup
resistor is already implemented in the PCB.

I2C communication is configured by switches, so the switches must be configured in order to
enable the 12C communication.



To enable 12C the switches SCL/I12.6(12.1) & SDA/I2.5(12.0) must be set to OFF thide. In
mode the inputs are totally disabled and the 12C is now enabled.

Industrial Shields does not provide any library to implement the 12C as it can be used the
standard library of Arduino called Wire.

104 SPI

The MDuino pins used for the SPI bus are sumipsatin the table below. For SPI bus MISO,
MOSI and CLOCK pins are common to all the connected devices teDhib conversely,
each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 9 50
MOSI 51 SI 51
CLOCK 52 SCK 52
Reset Reset Reset
SS SCL/SDA/RXO/TXO/RX1/TX1/RX3/TX3/Pin2/F 21/20/1/0/19/18/15/14/2/3

Check thewitch configuration at section ® enable SS pins.

10.5 TTL

M-Duino hasone TTLport, RXO/TXORX1/TX1s used for WH and BLE communicatipnlr TLO
is accessed with the function Serial (pins 0 and 1 of the Arduino Mega).

10.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the compatible IC compatible
with Arduino Ethernet2 Shield libraries. All &thet shield Arduino librées are compatible

with the M-Duino. In the MDuino, W5500 IC communicates to the Mega boaadSPI bus (SS
Arduino Mega pin 10

10.7 RTC

M-Duino RTC Module is based on th§1307 Chip. This chip works with the 12C protocol
commurication, so it is required to have enabled the 12C protocol.

4 switches have to be configured in order to enable the RTC features:



LEFT ZONE

SWITCH ON OFF
NC - -
NC - -

RTC SCL RTC -

RTC SDA RTC -

Switch Analog Shield

ON OFF

SCL/12.6 12.6 SCL

SDA/I2.5 12.5 SDA

RTC SCL & RTC SDA must be set to ON mode to
enablethe 12C wires to the RTC. If they are in OFF

mod e,

12C must be enabled in order to commuatie with
the RTC. See section IPLC to enable it.

t he

Ardui

no

won

t

Using the boards of Industrial Shields, there is a library that simplifieRTi@2implementation

called RTC.

10.8 uSD

commun

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol

is always enabled, as there are no switctiest configure it.However there is a switch that
must be placed to ON mode in order to communicate with the uSD:

D53(SD): If this Switch is OFF, it enables the Chip Select of the microSD socket and disables

Q2.0. If this switch is ON, it enables the Q2.(patitIf the switch is in ON mode the microSD

can’t

be

used.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of

the PLC, it is required to open the plastic found in the frontal partthadocket is located

under the supply of the Arduino.

Switch Analog Shield
ON OFF
D53(SD) Q2.0 | D53(SD)

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation

called SDIt is the same as the Arduino library, with the only modifaaof using the pin 53 to

selectthe Chip Select of the uSD chip.



10.9 WiFi & BLE

The WiFiand Bluetooth integrated module consistsin a single 2.4 GHzWi-Fi and Bluetooth
combochipdesignedwith the TSMQiltra-low-power40nmtechnology It isdesignedto achieve
the best power and RFperformance,showingrobustness versatility and reliability in a wide
variety of applicationsand power scenarios.Someapplicationsare GenericLow-power loT
Sensomtub, GenericLowpower loT DataLoggersaand MeshNetwork.

It isdesignedor Internet-of-Things(loT)applications.

10.9.1 GeneralSpecifications

Wi-Fi

1 802.11b/g/n

1 802.11n(2.4GHz)upto 150Mbps
Bluetooth

1 Bluetooth4.2 BR/EDRLEIualmode controller
1 +12dBmtransmittingpower
1 NZlIFeceiverwith -97 dBmBLEsensitivity

10.9.2 WiFi & Bluetooth Module Configuration

In orderto configurethe WiFi& BLEmodule,youmustconnectit to aPC.
Toconnectit youwill needa microUSBio USBcable.

Theslot for the micro USBinput is locatedon the right sideof your equipment.

Toloadthe programinto the ESP3%ou haveto installthe boardon the ArduinolDEsoftware
Goto File> Preferencesandinto AdditionalBoardsManagerURLsddthe next

URL https://dl.espressif.com/dl/package esp32 index.json

*If you already have one URL put it next to the other separeteddoya, like in the image
below.


https://dl.espressif.com/dl/package_esp32_index.json

Preferences

X
Settngs  Network
Sketchbook location:
C:\sers USER Documents\Arduing Browse
Editor language: English (Englsh) v | (requres restart of Arduino)
oo fort sze: 13
Interface scale: M Astomatic 100 % (requires restart of Arduino)
Thems: Defadt theme (requires restart of Arduino)
Show verbose output during: [ compilation [ upload
Compier warmnings: Nore
] Dspiay kne numbers
[ Enabie Code Folding
[ verfy code after upload
[T Us= external editor
4 Aggressively cache complied core
(A Check for updates on starhp
4 Undate sketch fiies to new extension on save (.pde -> .no)
[ Save when venfying or uploadng

Additonsl Boards Manager URLs: o,boads/padwot_mdmtrdﬁdds_hdex.jsm, hitp

More oreferences can be edited drectly in the fie

C:\Users USER \AppData Local\Arduino 15 preferences. txt

ot rurveng

Nowyouare ableto installthe board.Goto Tools> Boards> BoardsManagerand searchby
ESP32

Will appearthe esp32by EspressiSystemsinstallit.

Onceit isinstalledgoto Tools>Boardsand chooseESP3DevModule



D sketch_may17a | Arduino 180
Fie Edit Sketch Tools Help

Auto Form at cutsT
Aucheve Skeuch
shetch_rmay 17 Fix Encoding & Retoad
Sertal Monvtor CutaShift+M
“"; "1 Senal Plotter CutsShittsd

Wil 101 Fsrmware Updater

Flash Made: “Q10" p LilyPad Arcknno
; { Flash Frequency; “80MHz" X Archano Pro or Pro Mani
PUEY CpU Frequency; “240MHz (WiFi/BT)" . Arcuno NG of older
Flash Size- “4MB (32Mb)" 5 Arduino Robot Control
! PSRAM: “Disabled” Arduino Robot Motor
Partition Scheme. "Default AMB with spitfs {1 2MB APP/1.5MB SPIFFS)’ y  Arduno Gemma
Upload Speed 921600 y Adatrat Circult Prayground
Cote Debug Leved: "Nooe” | Arduno Yon Min
Port Arduino Industna 101
Get Board Into Linino One
Arcuno Uno Wik
Programmer: “Arduno Gemma® ¥ S92 Arching
Burn Bootoader . m'u'"“m" o
ESP32 Wrover Module
FSP32 Pico Kit
Tuwrta loT Node
TTGO LoRa22-OLED V1
XinaBox CW02
SparkFun ESP32 Thing
u-bhow NIMA-W 10 senes (ESP32)
Widora AIR

Electronic SweetPeas - ESP320

Theinternal connections between thESP32nodule and theArduino Mega are the following:

Arduino Mega Pinout ESP32 Pinout

5Vdc Vce
GND GND
Tx1 (Pin 18) TxD
Rx1 (Pinl19) RxD

WiFi and Bluetooth aralways enabled as there are no switches that configure it.

The WiFi and Bluetooth module us8sriall for communicatian



11 1/O technical detalils:

Digital Output Waveform:

[ o e—1
y

DIGITALOUT

CH1 ¥ Z&88ml)

DIGITAL OUT




Analog Out Turn On:

]

ANALOGOUT

ANALDG OUT




12 Typical Connections

~—— GND (100
S 224 e 10.0
GND %
= POWER
’ 1 B oeraw
/ Downioad ths MDUIWO LAYOUT: '
o warw xustrislsmakts com A

'\\/ DIGITAL NO-ISOLATED INPUT ,,)

\

() 10.0
Y N 100
~—— GND
E POWER
12/24V 0 oemaw
Downioad the MDUING LAYOUT:
/ Eror; www, indstrinlsiedds oo _
< T =13
(Digital) :
DS g — Y,

IS o POWER
e 12/24V B oemumaos i




P 512124V o O 0.7
=
- GND
G POWER
B B ocoamnaoew
) Donnlosd the MDUTNG LAYOUT:
/‘
G DIGITAL/ANALOG INPUT
(Analog)
o-10v
N, | or
GND
B POWER
L B oemamaoe v
Downiond the MOUINO LAYOUT:
From: www,
L DIGITAL/ANALOG INPUT
2 (Analog with external
alimentation)
0-10V
E’—‘) 512724V m)— 0.7
~—— GND
GND
g POWER
12/24v B oomamnaoo
Downoad e MOUMNO LAYOUT:
www indstrinishiedda oom

ol 1




(-- DIGITAL ISOLATED OUTPUT \

QN
Q/Vde SM2/24V ——
el A
COM({-) GND
ALWAYS
fﬁ Olos CONNECTED
- ._f]/ Q0.0 )
g{ GND POWER VOUT = Q/ Vdc
E— ! B oemaour
Downdosd the MOUINO LAYOUT:
From: www.ondvsiiahiads. com
| 55
/-v—“—__’———"ﬁ&
< DIGITAL NON-ISOLATED 2
\ QUTPUT /‘
/’—’_Qh\\
o7/ g )08 :
08|00 #/C{ 04 P
030 g Cle2
| comM () A
04| * ¢ oo ALWAYS
NG| 042 CONNECTED
~la ol Q0.0 { >}
%l
ND
) G POWER VOUT =Q/Vde
t:1—*12I24V §  opemaour
Download the MOUINO LAYOUT:
/ From: waww.induatiaéshields. com
~ ~
(I S | =)
\\\
{ DIGITAL / PWM ISOLATED P
OUTPUT
* See the swifch
configutarion (ON)
Q/Vde 5112724V E A
COM (-) GND 4
ALWAYS
mr,‘_pl/*—,;;m nn CONNECTED
o SA
= Q0.5 9,
?;'f GND POWER VOUT = Q/ Vde
12124V fl DIGITALPWM OUT
Domniaad the MOUING LAYOUT:
/ From: waw,



DIGITAL / PWM /)
NON-ISOLATED OUTPUT
AT * See the switch
07/0) g Olos configutarion (ON)
05 Oii o4
030 g Ol02 A
mio £gloo ALWAYS
nc[o Olod2 LN CONNECTED
g GNO POWER VOUT = Q/Vdo
12124V [ DIGITALPWM OUT
Downived the MDUIND LAYOUT:
\ ~
—
ANALOG OUTPUT
| *Analog Outs no led
indicator
A * Seo the switch
O 5 Olos configutarion (OFF)
O g Ofoz L ooV
8] g T
O Olos
o ok
—— GND
= POWER
12124V 4 ANALOG OUT
Downlosd the MOUWNO LAYOUT;
IO Wwww. oo



13 Connector details:

The connector inside the PLCs that mounts on the PCB is MC-G2/50THT 1963502

from Phoenix contactMCO0,5/16G-2,5THT

For 1/O andhower supplythere isa FkMC 0,5/10STF2,5- 1881406connector from Phoenix

contact FKMC 0,5/10SF2,5

Connection detaits

Article reference| MC 0,5/10G-2,5 THT|
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FKMC 0,5/16STF2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm2
Conduit section AWG/kcmil min, 26
Conduit section AWG/kemil max 20



https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1
https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1881406&library=usen&tab=1#General

Dimension :

129

DIN Rail mounting

14 Mechanical Characteristics
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AboutIndustrial Shield:

Direction:Fabrica del Pont,-11

Zip/Postal Coded8272

City:Sant Fruités d8ages (Barcelona)
Country:Spain

Telephone: {34) 938 760 191 / (+34935693611

Mail: industrialshields@industrialshields.com
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